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1. What is the AT command 

AT command is used for controlling module. You can use AT command to configure and query the settings.  

2. How to use the AT command 

For USR device is in transparent mode normally, you must enter AT command mode at first. Then you can send AT 

command to configure or query the settings. After you configure the USR device, you should restart the USR 

device to make the settings take effect. Every time module restart will work in work mode rather AT command 

mode. 

Every AT command must add character carriage return <CR> and line feed <LF>. In Hex, <CR> is 0x0D 

<LF> is 0x0A. 

2.1. How to enter serial AT command mode 

Please read this FAQ about entering serial AT command mode. 

https://www.usriot.com/support/faq/enter-serial-command-mode.html 

3. AT command set 

Command Function 

E Set AT command echo function enable/disable 

ENTM Exit serial AT command mode and enter work mode 

NETP Query/Set Network protocol parameters of socket A 

UART Query/Set serial port parameters 

UARTF Query/Set serial package function enable/disable 

UARTFT Query/Set serial package triggering time 

UARTFL Query/Set serial package triggering length 

TMODE Query/Set W610 work mode 

WMODE Query/Set WIFI mode(AP/STA) 

WSKEY Query/Set encryption parameters in STA mode 

WSSSID Query/Set SSID of connected AP in STA mode 

WSLK Query the connection status in STA mode 

WEBU Query/Set Web Server username and password 

WAP Query/Set AP mode parameters 

WAKEY Query/Set encryption parameters in AP mode 

MSLP Query/Set Sleep mode enable/disable 

WSCAN Search surrounding AP 

TCPLK Query socket A TCP connection connect/disconnected 

TCPDIS 
Query/Set establish TCP connection enable/disable(Only take effect in TCP Client 

mode) 

WANN Query/Set network parameters in STA mode(WAN interface parameters)  

LANN Query/Set network parameters in AP mode(LAN interface parameters) 

TCPTO Query/Set timeout re-connection function time of socket A 

http://www.usriot.com/
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MAXSK Query/Set maximum TCP Clients in TCP Server work mode 

TCPB Query/Set Socket B enable/disable 

TCPPTB Query/Set Socket B port number 

TCPADDB Query/Set Socket B server address 

TCPTOB Query/Set timeout re-connection function time of socket B 

TCPLKB Query socket B TCP connection connect/disconnected 

EPHY 
Set Ethernet interface enable/disable(Other two related commands AT+FEPHY 

AT+FVEW please see details in 4.29. AT+EPHY) 

RELD Reset W610 to user default setting 

FUDLX Set RS485 enable/disable 

MMID Query/Set module ID 

IDFIR 
Set sending two bytes ID and two bytes ID inverse code after firstly establishing 

connection enable/disable 

IDEVE 
Set sending two bytes ID and two bytes ID inverse code before every data 

enable/disable 

AABR Set baud rate synchronization function enable/disable 

DHCPDEN Set DHCP Server function of LAN interface enable/disable 

HIDESSID Set hiding SSID of W610 in AP mode enable/disable 

DOMAIN Query/Set Web Server domain name 

Z Restart the W610 

MID Query W610 MID 

VER Query firmware version 

H Query help information of commands 

WSQY Query/Set RSSI threshold(percentage) to switch among three AP in STA mode 

HTPMODE Query/Set HTTP Client mode parameters configuration way(new/old) 

HTTPURL Query/Set HTTP Server address and port in HTTP Client mode old configuration way 

HTTPTP Query/Set HTTP requesting method in HTTP Client mode old configuration way 

HTTPPH Query/Set HTTP header path in HTTP Client mode old configuration way 

HTTPCN Query/Set HTTP header connection in HTTP Client mode old configuration way 

HTTPUA Query/Set HTTP header User-Agent in HTTP Client mode old configuration way 

HTPSV Query/Set HTTP Server address and port in HTTP Client mode new configuration way 

HTPTP Query/Set HTTP requesting method in HTTP Client mode new configuration way 

HTPURL Query/Set HTTP URL in HTTP Client mode new configuration way 

HTPHEAD Query/Set HTTP header in HTTP Client mode new configuration way 

REGEN Query/Set identity packet type 

REGTCP Query/Set identity packet sending method 

WTPWR Query/Set W610 transmitting power 

REGCLOUD Query/Set USR Cloud ID and password 

REGUSR Query/Set user editable identity packet data  

TCPDPEN Query/Set socket distribution function enable/disable 

http://www.usriot.com/
http://h.usriot.com/


                    USR-W610 AT Command Set                        www.usriot.com 

 

 

Jinan USR IOT Technology Limited                          6 / 24                                    h.usriot.com 

HEARTEN Query/Set heartbeat packet function enable/disable  

HEARTTP Query/Set sending method of heartbeat packet 

HEARTDT Query/Set heartbeat packet data 

HEARTTM Query/Set sending interval of heartbeat packet 

REBOOTEN Query/Set timing restart function enable/disable 

REBOOTT Query/Set timing restart function time 

TIMEOUTEN Query/Set timeout restart function enable/disable 

TIMEOUTT Query/Set timeout restart function time 

 

4. AT command details 

Special Characters 

Character Note Hex 

<CR> Carriage Return 0x0D 

<LF> Line Feed 0x0A 

4.1. AT+E 

Format 

Set AT+E<CR> 

Return <CR><LF>+ok<CR><LF> 

 

Note: Default setting of echo function is on, user can send above command to close, then send above command 

again to open.  

4.2. AT+ENTM 

Format 

Set AT+ENTM<CR> 

Return <CR><LF>+ok<CR><LF> 

4.3. AT+NETP 

Parameter Description Default Value Range 

<Protocol> Network protocol of Socket A  TCP TCP/UDP 

<CS> Network mode of Socket A SERVER SERVER/CLIENT 

<Port> Port number of Socket A 8899 Less than 65535 

<Address> 
Remote Server address of 

Socket A in client mode 

10.10.100.10

0 

0.0.0.0~255.255.255.255 

Domain name 

Format 

Query AT+NETP<CR> 

Return <CR><LF>+ok=<Protocol>,<CS>,<Port>,<Address><CR><LF> 

Set AT+NETP=<Protocol>,<CS>,<Port>,<Address><CR> 

Return <CR><LF>+ok<CR><LF> 

http://www.usriot.com/
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Note: When Socket A work in TCP Server or UDP Server, port can’t be 80(HTTP port), 8000(websocket port), 

49000(usr-link port). 

4.4. AT+UART 

Parameter Description Default Value Range 

<Baud 

rate> 
Baud rate 57600 

300, 600, 1200,1800, 2400, 4800, 9600, 

19200, 38400, 57600, 115200, 230400, 

345600, 460800 

<Data bit> Data bits 8 5, 6, 7, 8 

<Stop bit> Stop bits 1 1, 2 

<Parity> Parity NONE NONE, EVEN, ODD 

<Flow 

Control> 
Flow Control NFC 

NFC: No flow control 

FC: Hardware flow control(RTS/CTS) 

Format 

Query AT+UART<CR> 

Return  
<CR><LF>+ok=<Baud rate>,<Data bit>,<Stop bit>,<Parity>,<Flow 

Control><CR><LF> 

Set AT+UART=<Baud rate>,<Data bit>,<Stop bit>,<Parity>,<Flow Control><CR> 

Return  <CR><LF>+ok<CR><LF> 

4.5. AT+UARTF 

Parameter Description Range 

<Status> Status of serial package function enable/disable 

Format 

Query AT+UARTF<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+UARTF=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.6. AT+UARTFT 

Parameter Description Range 

<Time> Serial package triggering time 100~10000ms 

Format 

Query AT+UARTFT<CR> 

Return <CR><LF>+ok=<Time><CR><LF> 

Set AT+UARTFT=<Time><CR> 

Return <CR><LF>+ok<CR><LF> 

4.7. AT+UARTFL 

Parameter Description Range 

<Length> Serial package triggering length 16~4096 bytes 

http://www.usriot.com/
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Format 

Query AT+UARTFL<CR> 

Return <CR><LF>+ok=<Length><CR><LF> 

Set AT+UARTFL=<Length><CR> 

Return <CR><LF>+ok<CR><LF> 

4.8. AT+TMODE 

Parameter Description Default Value Range 

<Mode> 

W610 data 

transmission 

mode  

Through 

Through: Transparent Transmission 

mode 

Agreement: Serial port command mode 

Modbus: Modbus TCP<=>Modbus RTU  

Httpdclient: HTTP Client mode 

Format 

Query AT+TMODE<CR> 

Return <CR><LF>+ok=<Mode><CR><LF> 

Set AT+TMODE=<Mode><CR> 

Return <CR><LF>+ok<CR><LF> 

4.9. AT+WMODE 

Parameter Description Default Value Range 

<Mode> W610 WiFi mode AP AP/STA 

Format 

Query AT+WMODE<CR> 

Return <CR><LF>+ok=<Mode><CR><LF> 

Set AT+WMODE=<Mode><CR> 

Return <CR><LF>+ok<CR><LF> 

4.10. AT+WSKEY 

Parameter Description Default Value Range 

<AUTH> 
Authentication 

mode 
OPEN OPEN/WPAPSK/WPA2PSK/SHARED 

<Encryption> 
Encryption 

algorithm 
NONE 

NONE: Take effect in <AUTH>=OPEN 

TKIP/AES: Take effect in 

<AUTH>=WPAPSK or WPA2PSK 

WEP-A/WEP-H: Take effect in 

<AUTH>=SHARED or OPEN(H means 

HEX, A means ASCII) 

<Password> Password 
No default 

value 

<AUTH>= WPAPSK/WPA2PSK: ASCII 

format, 8~63 bytes 

http://www.usriot.com/
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<Encryption>=WEP-A: ASCII format, 5 

or 13 bytes 

<Encryption>=WEP-H: HEX format, 10 

or 26 bytes 

Format 

Query AT+WSKEY<CR> 

Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF> 

Set AT+WSKEY=<AUTH>,<Encryption>,<Password><CR> 

Return <CR><LF>+ok<CR><LF> 

4.11. AT+WSSSID 

Parameter Description Range 

<SSID> SSID of connected AP in STA mode Less than 32 bytes 

Format 

Query AT+WSSSID<CR> 

Return <CR><LF>+ok=<SSID><CR><LF> 

Set AT+WSSSID=<SSID><CR> 

Return <CR><LF>+ok<CR><LF> 

4.12. AT+WSLK 

Parameter Description Range 

<Status> 

Connection status 

of W610 in STA 

mode 

Disconnected: No connection with any AP 

SSID of connected AP if connected 

RF Off: Close WIFI 

Format 

Query AT+WSLK<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

4.13. AT+WEBU 

Parameter Description Default Value Range 

<Username> Username of Web Server admin Less than 16 bytes 

<Password> Password of Web Server admin Less than 16 bytes 

Format 

Query AT+WEBU<CR> 

Return <CR><LF>+ok=<Username>,<Password><CR><LF> 

Set AT+WEBU=<Username>,<Password><CR> 

Return <CR><LF>+ok<CR><LF> 

4.14. AT+WAP 

Parameter Description Range 

<Mode> WiFi mode 11B/11BG/11BGN/11G/11N 

http://www.usriot.com/
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<SSID> SSID in AP mode Less than 32 bytes 

<Channel> WiFi channel AUTO/CH1~CH11 

Format 

Query AT+WAP<CR> 

Return <CR><LF>+ok=<Mode>,<SSID>,<Channel><CR><LF> 

Set AT+WAP=<Mode>,<SSID>,<Channel><CR> 

Return <CR><LF>+ok<CR><LF> 

4.15. AT+WAKEY 

Parameter Description Default Value Range 

<AUTH> 
Authentication 

mode 
OPEN OPEN/SHARED/WPAPSK/WPA2PSK 

<Encryption> 
Encryption 

algorithm 
NONE 

NONE: Take effect in <AUTH>=OPEN 

WEP-A/WEP-H: Take effect in 

<AUTH>=SHARED or OPEN(H means 

HEX, A means ASCII) 

TKIP/AES/TKIPAES: Take effect in 

<AUTH>= WPAPSK/WPA2PSK 

<Password> Password 
No default 

value 

<AUTH>= WPAPSK/WPA2PSK: ASCII 

format, 8~63 bytes 

<Encryption>=WEP-A: ASCII format, 5 

or 13 bytes 

<Encryption>=WEP-H: HEX format, 10 

or 26 bytes 

Format 

Query AT+WAKEY<CR> 

Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF> 

Set AT+WAKEY=<AUTH>,<Encryption>,<Password><CR> 

Return <CR><LF>+ok<CR><LF> 

4.16. AT+MSLP 

Parameter Description Default Value Range 

<Status> Status of Sleep mode on 
on: Exit Sleep mode 

off: Enter Sleep mode 

Format 

Query AT+MSLP<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+MSLP=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

Note: When module enter sleep mode and user send AT+MSLP=ON to exit sleep mode, module will enter AT 

command mode. 

http://www.usriot.com/
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4.17. AT+WSCAN 

Parameter Description 

<RSSI> RSSI of AP that be searched by W610 

<SSID> AP’s SSID that be searched by W610 

<BSSID> MAC address of AP that be searched by W610 

<Channel> WiFi network channel  

<Encryption> Encryption algorithm of AP that searched by W610 

<Authenticatio

n> 
Authentication mode of AP that searched by W610 

Format 

Query AT+WSCAN<CR> 

Return 

<CR><LF>+ok=<LF><CR>RSSI,SSID,BSSID,Channel,Encryption,Authenticati

on<LF><CR><RSSI1><SSID1>,<BSSID1>,<Channel1>,<Encryption1>,<Auth

entication1><LF><CR><RSSI2><SSID2>,<BSSID2>,<Channel2>,<Encryptio

n2>,<Authentication2><LF><CR>.....<LF><CR><RSSIN><SSIDN>,<BSSIDN>,

<ChannelN>,<EncryptionN>,<AuthenticationN><CR><LF> 

4.18. AT+TCPLK 

Parameter Description Range 

<Status> Status of TCP connection of Socket A  
on: TCP connection connected 

off: TCP connection disconnected 

Format 

Query AT+TCPLK<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

4.19. AT+TCPDIS 

Parameter Description Default Value Range 

<Status> 

Allowing 

establishing 

TCP 

connection in 

TCP Client 

mode 

on 

on: Allow connecting, after setting to 

on, starting to connect to server 

immediately  

off: Disallow connecting, after setting 

to off, disconnecting immediately and 

not to reconnect 

Format 

Query AT+TCPDIS<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+TCPDIS=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

 

http://www.usriot.com/
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4.20. AT+WANN 

Parameter Description Default Value Range 

<Mode> 
 How to get IP address in 

STA mode 
DHCP static/DHCP 

<IP address> IP address in STA mode 0.0.0.0  0.0.0.0~255.255.255.255 

<Mask> Subnet mask in STA mode 0.0.0.0  0.0.0.0~255.255.255.255 

<Gateway> 
Gateway address in STA 

mode 
0.0.0.0  0.0.0.0~255.255.255.255 

Format 

Query AT+WANN<CR> 

Return <CR><LF>+ok=<Mode>,<IP address>,<Mask>,<Gateway><CR><LF> 

Set AT+WANN=<Mode>,<IP address>,<Mask>,<Gateway><CR>  

Return <CR><LF>+ok<CR><LF> 

4.21. AT+LANN 

Parameter Description Default Value Range 

<IP address> 
IP address of W610 in AP 

mode  
10.10.100.254  0.0.0.0~255.255.255.255 

<Mask> 
Subnet mask of W610 in 

AP mode  
255.255.255.0 0.0.0.0~255.255.255.255 

Format 

Query AT+LANN<CR> 

Return <CR><LF>+ok=<IP address>,<Mask><CR><LF> 

Set AT+LANN=<IP address>,<Mask><CR> 

Return <CR><LF>+ok<CR><LF> 

Note: WAN interface IP(AT+WANN) and LAN interface IP(AT+LANN) can’t in same network segment. 

4.22. AT+TCPTO 

Parameter Description Default Value Range 

<Time> 
Timeout re-connection time 

of socket A 
0 

0-600s 

0 (Close function) 

Format 

Query AT+TCPTO<CR> 

Return <CR><LF>+ok=<Time><CR><LF> 

Set AT+TCPTO=<Time><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.23. AT+MAXSK 

Parameter Description Default Value Range 

<NUM> 
Maximum TCP Clients that W610 

support in TCP Server 
24 1~24 

Format 

Query AT+MAXSK<CR> 

Return <CR><LF>+ok=<NUM><CR><LF> 

Set AT+MAXSK=<NUM><CR> 

Return <CR><LF>+ok<CR><LF> 

4.24. AT+TCPB 

Parameter Description Range 

<Status> Status of socket B on/off 

Format 

Query AT+TCPB<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+TCPB=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.25. AT+TCPPTB 

Parameter Description Range 

<Port>  Port number of Socket B  1~65535 

Format 

Query AT+TCPPTB<CR> 

Return <CR><LF>+ok=<Port><CR><LF> 

Set AT+TCPPTB=<Port><CR> 

Return <CR><LF>+ok<CR><LF> 

4.26. AT+TCPADDB 

Parameter Description Range 

<Address> Remote server address of socket B  
0.0.0.0~255.255.255.255 

Domain name 

Format 

Query AT+TCPADDB<CR> 

Return <CR><LF>+ok=<Address><CR><LF> 

Set AT+TCPADDB=<Address><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.27. AT+TCPTOB 

Parameter Description Default Value Range 

<Time> 
Timeout re-connection 

time of socket B 
0 

0-600s 

0 (Close function) 

Format 

Query AT+TCPTOB<CR> 

Return <CR><LF>+ok=<Time><CR><LF> 

Set AT+TCPTOB=<Time><CR> 

Return <CR><LF>+ok<CR><LF> 

4.28. AT+TCPLKB 

Parameter Description Range 

<Status> 
Status of TCP connection of 

Socket B  

on: TCP connection connected 

off: TCP connection disconnected 

Format 

Query AT+TCPLKB<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

4.29. AT+EPHY 

Format 

Set AT+EPHY<CR> 

Return <CR><LF>+ok<CR><LF> 

Note: To reduce power consumption, default of Ethernet interface is off. When user sends above AT+EPHY 

command to open Ethernet interface, the setting won’t be saved after restarting(Ethernet interface will disable 

after restarting). So user can send AT+FEPHY=on to enable Ethernet interface permanently. 

 

User can also use AT+FVEW=disable/enable to set Ethernet interface in LAN interface(disable) or WAN 

interface(enable). This command will take effect after resetting to default settings. 

4.30. AT+RELD 

Format 

Set AT+RELD<CR> 

Return <CR><LF>+ok=rebooting...<CR><LF> 

4.31. AT+FUDLX 

Parameter Description Range 

<Status> Status of RS485 function on/off 

Format 

Set AT+FUDLX=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

Note: Default of RS485 is off and this command will take effect after resetting to default settings. 

http://www.usriot.com/
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4.32. AT+MMID 

Parameter Description Range 

<ID> Module ID 0~65535 

Format 

Query AT+MMID<CR> 

Return <CR><LF>+ok=<ID><CR><LF> 

Set AT+MMID=<ID><CR> 

Return <CR><LF>+ok<CR><LF> 

4.33. AT+IDFIR 

Parameter Description Default Range 

<Status> 

Status of sending two bytes ID and two 

bytes ID inverse code after firstly 

establishing connection function 

off on/off 

Format 

Query AT+IDFIR<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+IDFIR=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.34. AT+IDEVE 

Parameter Description Default Range 

<Status> 
Status of sending two bytes ID and two bytes 

ID inverse code before every data function 
off on/off 

Format 

Query AT+IDEVE<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+IDEVE=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.35. AT+AABR 

Parameter Description Default Range 

<Status> Status of baud rate synchronization function on on/off 

Format 

Query AT+AABR<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+AABR=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.36. AT+DHCPDEN 

Parameter Description Default Range 

<Status> Status of LAN interface DHCP Server function on on/off 

Format 

Query AT+DHCPDEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+DHCPDEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.37. AT+HIDESSID 

Parameter Description Default Range 

<Status> Status of hiding SSID of W610 in AP mode  off on/off 

Format 

Query AT+HIDESSID<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+HIDESSID=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.38. AT+DOMAIN 

Parameter Description 

<Name> Domain name to enter Web Server 

Format 

Query AT+DOMAIN<CR> 

Return <CR><LF>+ok=<Name><CR><LF> 

Set AT+DOMAIN=<Name><CR> 

Return <CR><LF>+ok<CR><LF> 

4.39. AT+Z 

Format 

Set AT+Z<CR> 

Return <CR><LF>+ok<CR><LF> 

4.40. AT+MID 

Parameter Description 

<MID> 
Module MID, format: A11-yymmddnnnn. yymmdd means produced date 

year/month/day. nnnn means production series number 

Format 

Query AT+MID<CR> 

Return <CR><LF>+ok=<MID><CR><LF> 
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4.41. AT+VER 

Parameter Description 

<VER> Firmware version of the module 

Format 

Query AT+VER<CR> 

Return <CR><LF>+ok=<VER><CR><LF> 

4.42. AT+H 

Parameter Description 

<Help> Command help information 

Format 

Query AT+H<CR> 

Return <CR><LF>+ok=<Help><CR><LF> 

4.43. AT+WSQY 

Parameter Description Default Value Range 

<Ret> 
RSSI 

threshold(percentage) 
100 

0~100. 100: Not to 

automatically switch AP 

Format 

Query AT+WSQY<CR> 

Return <CR><LF>+ok=<Ret><CR><LF> 

Set AT+WSQY=<Ret><CR> 

Return <CR><LF>+ok<CR><LF> 

4.44. AT+HTPMODE 

Parameter Description Default Value Range 

<Type> HTTP Client configuration mode new new/old 

Format 

Query AT+HTPMODE<CR> 

Return <CR><LF>+ok=<Type><CR><LF> 

Set AT+HTPMODE=<Type><CR> 

Return <CR><LF>+ok<CR><LF> 

4.45. AT+HTTPURL 

Parameter Description Range 

<Address> Server address  
IP address: 0.0.0.0~255.255.255.255 

Domain name: 1-64 bytes 

<Port> Server port 0-65535 

Format 

Query AT+HTTPURL<CR> 
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Return <CR><LF>+ok=<Address>,<Port><CR><LF> 

Set AT+HTTPURL=<Address>,<Port><CR> 

Return <CR><LF>+ok<CR><LF> 

4.46. AT+HTTPTP 

Parameter Description Default Value Range 

<Method> HTTP requesting method  GET GET/PUT/POST 

Format 

Query AT+HTTPTP<CR> 

Return <CR><LF>+ok=<Method><CR><LF> 

Set AT+HTTPTP=<Method><CR> 

Return  <CR><LF>+ok<CR><LF> 

4.47. AT+HTTPPH 

Parameter Description Default Value 

<Path> HTTP header path  /abcd 

Format 

Query AT+HTTPPH<CR> 

Return <CR><LF>+ok=<Path><CR><LF> 

Set AT+HTTPPH=<Path><CR> 

Return  <CR><LF>+ok<CR><LF> 

4.48. AT+HTTPCN 

Parameter Description Default Value 

<Connection> HTTP header connection keep-alive 

Format 

Query AT+HTTPCN<CR> 

Return <CR><LF>+ok=<Connection><CR><LF> 

Set AT+HTTPCN=<Connection><CR> 

Return  <CR><LF>+ok<CR><LF> 

4.49. AT+HTTPUA 

Parameter Description Default Value 

< User-Agent> HTTP header User-Agent lwip1.3.2 

Format 

Query AT+HTTPUA<CR> 

Return <CR><LF>+ok=< User-Agent><CR><LF> 

Set AT+HTTPUA=< User-Agent><CR> 

Return  <CR><LF>+ok<CR><LF> 
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4.50. AT+HTPSV 

Parameter Description Range 

<Address> Server address  
IP address: 0.0.0.0~255.255.255.255 

Domain name: 1-64 bytes 

<Port> Server port 0-65535 

Format 

Query AT+HTPSV<CR> 

Return <CR><LF>+ok=<Address>,<Port><CR><LF> 

Set AT+HTPSV=<Address>,<Port><CR> 

Return <CR><LF>+ok<CR><LF> 

4.51. AT+HTPTP 

Parameter Description Default Value Range 

<Method> HTTP request method  GET GET/PUT/POST 

Format 

Query AT+HTPTP<CR> 

Return <CR><LF>+ok=<Method><CR><LF> 

Set AT+HTPTP=<Method><CR> 

Return  <CR><LF>+ok<CR><LF> 

4.52. AT+HTPURL 

Parameter Description Default Value Range 

<URL> HTTP URL  /abcd Length:1~64 bytes 

Format 

Query AT+HTPURL<CR> 

Return <CR><LF>+ok=<URL><CR><LF> 

Set AT+HTPURL=<URL><CR> 

Return <CR><LF>+ok<CR><LF> 

4.53. AT+HTPHEAD 

Parameter Description Default Value Range 

<Header> 
HTTP header 

data 

Content-type:text/html;chars

et=utf-8(User should use 

<<CRLF>> to replace carriage 

return and line feed) 

Length: 0~200 bytes 

Format 

Query AT+HTPHEAD<CR> 

Return <CR><LF>+ok=<Header><CR><LF> 

Set AT+HTPHEAD=<Header><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.54. AT+REGEN 

Parameter Description Default Value Range 

<Status> 

Status of 

identity 

packet 

off 

id: Use 2 bytes ID code and 2 bytes ID 

inverse code as identity packet 

mac: Use 6 bytes MAC address as 

identity packet 

usr: Use user editable identity 

packet, less than 32 bytes 

cloud: Use USR Cloud ID as identity 

packet(only support FIRST method) 

off: Disable the identity packet 

function 

Format 

Query AT+REGEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+REGEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.55. AT+REGTCP 

Parameter Description Default Value Range 

<Method> 

Identity 

packet 

sending 

method 

first 

first: Only sending identity packet 

before first packet after firstly 

connecting to server 

every: Sending identity packet in 

every packet. 

Format 

Query AT+REGTCP<CR> 

Return <CR><LF>+ok=<Method><CR><LF> 

Set AT+REGTCP=<Method><CR> 

Return <CR><LF>+ok<CR><LF> 

4.56. AT+WTPWR 

Parameter Description Default Value Range 

<NUM> Module transmitting power  100 0~100 

Format 

Query AT+WTPWR<CR> 

Return <CR><LF>+ok=<NUM><CR><LF> 

Set AT+WTPWR=<NUM><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.57. AT+REGCLOUD 

Parameter Description Range 

<ID> USR Cloud ID Length: 20 bytes 

<Password>  USR Cloud password Length: Less than 8 bytes 

Format 

Query AT+REGCLOUD<CR> 

Return <C+R><LF>+ok=<ID>,<Password><CR><LF> 

Set AT+REGCLOUD=<ID>,<Password><CR> 

Return <CR><LF>+ok<CR><LF> 

4.58. AT+REGUSR 

Parameter Description Default Value Range 

<Data> 
User editable 

identity packet data 

7777772E7573722

E636E 

Length: Less than 40 bytes, 

HEX format 

Format 

Query AT+REGUSR<CR> 

Return <CR><LF>+ok=<Data><CR><LF> 

Set AT+REGUSR=<Data><CR> 

Return <CR><LF>+ok<CR><LF> 

4.59. AT+TCPDPEN 

Parameter Description Default Value Range 

<Status> Status of socket distribution function off on/off 

Format 

Query AT+TCPDPEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+TCPDPEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.60. AT+HEARTEN 

Parameter Description Default Value Range 

<Status> Status of heartbeat packet function off on/off 

Format 

Query AT+HEARTEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+HEARTEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 
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4.61. AT+HEARTTP 

Parameter Description Default Value Range 

<Type> 
Sending method of 

heartbeat packet  
NET 

NET: Sending to Network Server 

COM: Sending to serial port 

Format 

Query AT+HEARTTP<CR> 

Return <CR><LF>+ok=<Type><CR><LF> 

Set AT+HEARTTP=<Type><CR> 

Return <CR><LF>+ok<CR><LF> 

4.62. AT+HEARTDT 

Parameter Description Default Value Range 

<Data> Heartbeat packet data 
7777772E7573

722E636E 

Less than 40 bytes, HEX 

format 

Format 

Query AT+HEARTDT<CR> 

Return <CR><LF>+ok=<Data><CR><LF> 

Set AT+HEARTDT=<Data><CR> 

Return <CR><LF>+ok<CR><LF> 

4.63. AT+HEARTTM 

Parameter Description Default Value Range 

<Interval> 
Heartbeat packet 

sending interval 
30s 

Can be set between 

1-65535s. But keep-alive 

time is 60s, so Heartbeat 

packet sending interval can 

only take effect between 

1-60s. 

Format 

Query AT+HEARTTM<CR> 

Return <CR><LF>+ok=<Interval><CR><LF> 

Set AT+HEARTTM=<Interval><CR> 

Return <CR><LF>+ok<CR><LF> 

4.64. AT+REBOOTEN 

Parameter Description Default Value Range 

<Status> Status of timing restarting function off on/off 

Format 

Query AT+REBOOTEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

http://www.usriot.com/
http://h.usriot.com/


                    USR-W610 AT Command Set                        www.usriot.com 

 

 

Jinan USR IOT Technology Limited                          23 / 24                                    h.usriot.com 

Set AT+REBOOTEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.65. AT+REBOOTT 

Parameter Description Default Value Range 

<Time> Time of timing restarting function 24h 1~720h 

Format 

Query AT+REBOOTT<CR> 

Return <CR><LF>+ok=<Time><CR><LF> 

Set AT+REBOOTT=<Time><CR> 

Return <CR><LF>+ok<CR><LF> 

4.66. AT+TIMEOUTEN 

Parameter Description Default Value Range 

<Status> Status of timeout restarting function off on/off 

Format 

Query AT+TIMEOUTEN<CR> 

Return <CR><LF>+ok=<Status><CR><LF> 

Set AT+TIMEOUTEN=<Status><CR> 

Return <CR><LF>+ok<CR><LF> 

4.67. AT+TIMEOUTT 

Parameter Description Default Value Range 

<Time> Time of timeout restarting function 3600s 60-65535s 

Format 

Query AT+TIMEOUTT<CR> 

Return <CR><LF>+ok=<Time><CR><LF> 

Set AT+TIMEOUTT=<Time><CR> 

Return <CR><LF>+ok<CR><LF> 
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5. Contact 

Company: Jinan USR IOT Technology Limited 

Address:  Floor 11, Building No.1, No.1166, Xinluo Street, Gaoxin District, Jinan city, Shandong province, 250101 

China 

Tel: 86-531-88826739 

Web: www.usriot.com  

Support: h.usriot.com   

Email: sales@usr.cn 

 

6. Disclaimer 

This document provides the information of USR-W610 products, it hasn’t been granted any intellectual property 

license by forbidding speak or other ways either explicitly or implicitly. Except the duty declared in sales terms 

and conditions, we don’t take any other responsibilities. We don’t warrant the products sales and use explicitly or 

implicitly, including particular purpose merchant-ability and marketability, the tort liability of any other patent 

right, copyright, intellectual property right. We may modify specification and description at any time without 

prior notice.  

 

7. Update History  

2018-06-27  V1.0.0 created. 
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